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>>> Unannounced Special Bonus On Last Page <<<

Hello,

Thank you for requesting this information; these are the exact steps |
have taken to build my blog www.DeanHolland.com

You can follow my journey and build your own blog right away with
what I’'m about to teach you

I’m no expert and I'm definitely no guru, in fact I’'m probably not much
further ahead than you are right now.

You can read my story on my blog at DeanHolland.com

Feel free to use my blog as a platform to help you with your business,
follow what I am doing and together we will all have success online
and make the money we all know is possible to make.

Have any questions?

Post them on my blog and | will personally reply to them

Right lets get started ... Enjoy :)

Dean Holland . . . Who??

Before | tell you exactly how I built my blog so you can copy to start
your own business | want to tell you a bit about me and my story.

As you know my name is Dean Holland and | am 24 years old. I live in
Nottinghamshire in England UK.

So, am | rich? Nope ... Not yet
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Do | do what I like with my time? Hell no... I work 10+ hours a day at
a full time job

For now!

So why the heck should you listen to what I have to say?

Because | am going to succeed. | have always known deep inside that
I am going to be a millionaire one day; | just never knew how Until
many months back when | discovered Internet Marketing!

That’s right, I have spent well over a year trying and trying but getting
absolutely nowhere. And it’'s only now that | have a highly successful
mentor that | realise what | have done wrong for the last year.

So who is this mentor?

Alex Jeffrey’s!!

Here’s me meeting Alex at a seminar ©
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Let me tell you quickly how this happened

You see | have been on Alex’'s subscriber list for some time, since the
release of his product - Post Launch Profits

If you haven’t read it you should, he gives it away for free anyway so
go get it

Well a few weeks back | get this email from Alex telling me about a
seminar in London that he is speaking at for the first time.

The seminars was £97 . . . But get this, Alex was offering to pay for
the first 10 people to respond to his email!

Wow!
I was gunna go before | read that so now try and stop me!

So | took action and headed off to London for 3 days to go meet Alex
Jeffrey’s.

What an experience... What a guy!

I spent those 3 days pumping advice out of Alex and getting all the
help | could.

| like to think that Alex saw something in me, a passion for success
and a willingness to take action.

You have no idea what meeting Alex did for my mindset!

Spending 3 days with the rich and famous almost feels like a size 15
boot has been rammed up my backside!! (Ouch)

I left that seminar knowing that | had to take action; I have to work
hard if I want to live the life style that | so badly want
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And you know what. .

I love every minute of it!

Yes I’'m working over 10 hours a day at my job and yes I’'m then
coming home to sit on my pc for another 2-4 hours every night to
build my business

But so what!!!

Look, I don’t have much money right now but | do have time so my
investment is my time, the more | put in the more | will get out

It is applying that very mindset that has made me realise what went
wrong for the last 12 months

I've spent the last year going from program to program hunting for the
money online

Did | find it...? NO

I just gave up after trying the latest 'Instant Money Making' program
week after week

Looking back I'm pretty certain some of the programs or systems |
tried would have made good money. I just never stuck with them long
enough to find out. I now know that to be successful online we have to
build a business

Realise - this is business... Big business

We have got to start and lay the foundations for success, no short
cuts, and no magic button

Why?
Because that crap doesn’t exist!
If you believe it does then you have been sold the dream!

For a whole year | was sold that same dream...
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“Make $27,000 in 6 weeks”
“Quit your day job in 1 month”

Yeah right! Stop believing it and come with me on this journey I'm
taking

Lets do it right, lets work hard and achieve our dreams
Most importantly. .
Let’s do it together!

Oh yeah, Alex just recently released a new book on that subject called
'‘Gurus Dream’

Again its free and will really open your eyes to this business !

Check it out here == Gurus Dream Report

You wanna see something incredible??

Check this out then ...
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That picture right there shows the first 15 days traffic stats of my blog
being online... 1215 visits!! Not bad huh?

What about this.... My first ever affiliate promotion on my blog, this
was for Alex Jeffrey’s coaching program...
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That's $1729 profit to me... In 8 days!!
How about that?

Remember | have tried for well over a year and made nothing, now
look at what | am achieving ©

So join me on this journey now, from the beginning

Think about this;

I could keep learning and taking action myself and start to make good
money online.

With the help of Alex Jeffrey’s I could go build my business and
become very successful
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Then once I've made it | could sell you a product telling how I did it
and how rich I am

Right?
Sound familiar??
Or...

I could start my business as | have done with DeanHolland.com and
detail my every move so you can follow me as and when | do it

Together we all become successful at the same time!

We all help each other, we all have different skills so combine them
and we can all rocket to the very top

Now that I like the sound of!! . . How about you?

I sure hope so

So it all starts here, | have put this report together to show you what |
have done so far and exactly how | have done it, Step by step !

Absolutely nothing left out, every single thing I have learnt about
building a blog is right here

Please enjoy it, use it, and follow it and TAKE ACTION!
Remember any questions you have post them at

www.DeanHolland.com and I will answer them or find you someone
that can

Let’s do this!
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Set Up a free Wordpress Blog

So if you have read my blog you will know that | began building my
blog on Wordpress.com

It is absolutely free to get a blog at Wordpress.com and you can get
started
right away.

If you start a blog there be aware that Wordpress host your site and
you are limited by what you can do with your blog.

You really want a blog that you host yourself which gives you the
control to do anything at all with your blog; 1 will explain this process a
little further on for you.

For now let me tell you how to start a free blog on Wordpress.com
Once you are up and running you can transfer everything you have
created on your free blog to a self hosted one anyway so nothing will
be lost.

This will just give you a feel for how its all done without spending any
money. This is the way | did it, if you wish to go straight for a self
hosted blog then that’s fine. Just skip past this section to learn the
best way of doing so.

Let’s get started.....

Go to www.wordpress.com

At the top of the page you will see a big blue button that says 'Sign
up Now'
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2 WordPress.com » Get a Free Blog Here - Microsoft Internet Explorer |;HEWX|
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Next you will need to fill in the details required - Username / Password
/ Email and select if you want a blog or just a username.

You want to select a blog.
Then click "Next'

On the following screen you will have to choose your domain for your
blog, the title for your blog, the language and privacy.

Now choose your domain wisely as this cannot be changed once setup
although if you want to establish yourself properly online you are
going to want to get your own domain name.

Preferably a Dot Com domain. | would suggest you choose your name
as your domain like 1 have with DeanHolland.com
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You can go with any domain register company to do this, | used
GoDaddy.com which cost about $10 a year for my original purchase
although since then have discovered namecheap.com, this cost about
$9. All you will do once you have purchased a domain name is to
forward the domain to your WordPress blog domain that you entered
above.

Ok, so once you have entered your details simply click 'Signup’
You will then be instructed to check your email box for a confirmation
email that contains a link you click to activate your account.

Once you have activated your account you can get started with your
blog.

Now, | could write pages and pages of what you can do within your
Wordpress account and it would probably put you off reading anymore
of this report so I am going to make a suggestion to you.

Just go into your account and before you start writing spend some
time clicking the various options and see what is on offer to you.
That’s how | learned, it really wont take you long to get used to at all.
So there you have it, you got your own piece of land in internet space
Once you have learned your way through Wordpress you can then

begin to build interesting property on your land for people to look at -
i.e. write posts on your blog ©

Get control over your Blog!

So by now you should have your blog setup on Wordpress.com and
have a post or 2 on there.

You should also hopefully have got yourself a domain name, either
your name or a name suitable to the niche of your blog.

So what’s next?
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Well now you want to grab the bull by the horns and take control of
your own business.

Time to get some web hosting and start hosting your own blog.

Of course please don’t think you have to do this, you could remain
with a free wordpress.com blog but you should be aware of something.
Something VERY... VERY important.....

As your blog is on their hosting they own the blog not you.

You therefore have no ownership of that blog, this also means they
could remove your blog at anytime and you would lose all the work
you have done to it.

Now this can be for many reasons but it could be down to any spam
complaints they may receive about you and your blog. A jealous
competitor could easy get your blog closed simply by putting in a
complaint about you!

Sad but true so just be aware of that.

So what do you need in a web hosting provider?

If you choose the right host this process is far simpler than | ever
thought it would be.

What you basically need is hosting that comes with Cpanel and you
also need it to have software called Fantastico.

Fantastico is a piece of software that has Wordpress built into it so
once you go to your Cpanel all you do is click into Fantastico and click
to install Wordpress.

The easiest hosting to use is Hostgator

Hostgator has everything you need to get started quickly and easily,

this is what | use as my friend Alex Jeffrey’s of Post Launch Profits
recommended them to me.

© Copyright 2008 DeanHolland.com All Rights Reserved.



http://www.deanholland.com/uses/hostgator
http://www.deanholland.com/

Get your hosting with them here

=> Dean Holland Recommends Hostgator Hosting

One of the most important points for me with Hostgator is the fact
they have 24/7 live chat support. This is something that has proved
extremely valuable to the running of my business.

Update Name servers

Once you have your hosting account set up with Hostgator they will
send you an email to let you know the account has been activated.
You will then get a second email that contains your account settings,
this will include your name servers.

These will be 2 lines that look something like this;

Nns10l1.hostgator.com
Nns102.hostgator.com

Now as | don’t know what domain registrar you purchased your
domain name at I cannot tell you all exactly how to update your name
servers.

They will all be very similar so it shouldn’t be too difficult to do. If you
log into your domain registrar account and locate the settings section
you should be able to find the name server settings.

All you need to do is replace the current name servers with the 2 that

you receive in your account details email from Hostgator then save the
changes.

There you go... done!
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Install your Wordpress Blog to your hosting with
Fantastico

Once you've got your Hostgator hosting you need to get Wordpress
installed.

Rather than me type in the details of this I'm going to recommend you
go watch this short video on Matt Garrett's blog tactics website.

This is a free resource and | highly suggest you go look through what
he has to offer.

I had the pleasure of meeting Matt at a seminar recently and this guy
knows his stuff.

This is the very same video that taught me with DeanHolland.com and
is only a very short presentation

Install Wordpress with Fantastico video >
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There is so much to learn about what can now be done with your blog
once you host it yourself.

You can now change the theme, add new pages, change the sidebar....
anything you want really, its all yours !

How to transfer all information from a free blog to
your own blog

So you have your hosting set up, you have installed the Wordpress
blog with Fantastico following the above video and now you want to
move all the work you did with the free blog on wordpress.com to your
new blog.

You are not going to believe how simple this is!

Step 1
Log into your Wordpress.com blog account

Step 2
Go to the dashboard for your blog

Step 3
Click on the "Manage" tab

Step 4
Click the "Export’ tab

Step 5
Click the 'Download export file' button on the screen

Step 6
A download file box will pop up and give you the option to open or
save the file

Choose save
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Step 7
Choose a location on your computer to save the file to

And that’s it, now to put it into your new self hosted blog . . .

(Remember this is assuming you are using Hostgator hosting as
that is what | can show you)

Step 1
Log into your blog, this will probably be at address;

www.YOURDOMAIN.com/wp-admin

Step 2
Click the "Manage’ tab

Step 3
Click the "Import’ tab

Step 4

You will now be given a list of places to import from. You will want to
choose the

"Wordpress' import option

Step 5

Click the "'Browse’ button and select the file on your computer that
you saved

when you exported it from Wordpress.com

Step 6
Then just click the "Upload file and import®' button to finish the job

That’s it, all done!

Everything that was on your old Wordpress.com blog is now all in your
new blog

and you can do anything you like with it.

Great and well done!
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Monitor what goes on with your business

To know what works and what doesn’t work you will want to monitor
the traffic
coming to your blog.

For that | suggest Google analytics, if you haven’t heard of this before
itisa

free service that Google offers and you will get lots of great
information about the visitors to your site.

Firstly go get yourself a free Google analytics account here:

| Google Analytics - Microsoft Internet Explorer
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Once you have signed up and gone through the steps they will give
you a piece

of code that you must copy and paste into your blog

(Don’t worry it wont display on your blog or affect it in any way)

Right, so once you have the tracking code you need to log in to your
Wordpress admin area for your blog.
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Once in your WP admin area follow these steps to implement;

Step 1
Click on the 'Design’ tab

Step 2
Click the 'Theme editor' tab

Step 3

To the right of your screen you will see a list of options to select,
click on the 'Footer(Footer.php)’ option in that list

**NOTE**

At this point I advise you copy the code that is in the box on
your screen and just paste it into a notepad document to save
it. This is just in case something goes wrong, then you still
have the original code to put back.

Step 4
You will now see some code in the display box.

You need to look at that code and find the text that reads:
</body>
Once you find that put your curser directly before that text and paste

in the Google tracking code.

Step 5
At the bottom of the screen click "Update file' to save the changes

And that's it !
You are now tracking what goes on in your business

If you log in to your Google analytics account you will see that it is
now gathering data about your site.
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After 24 hours of installing analytics you will be able to review the data
daily

Have a good look around your analytics account and see the great
information you can receive. You can use this information to see which

of your efforts are pulling in the traffic meaning you can put more of
your time and effort into the methods that bring the best results.

Setup email accounts in your cPanel

Once everything is up and running you know will want to get at least 1
email account for your domain. Primarily you will want;

Yourname @ your domain DOT com

Then of course you can have any other email account that you wish,
such as;

Support @ your domain DOT com
Questions @ your domain DOT com

Now to do this log into your hosting cPanel account and then follow
these steps;

In cPanel look for the ‘Mail’ section, within that section locate the
symbol ‘Email accounts’

Then follow these steps;

Step 1

Click ‘Email accounts’

Then on the next screen you have the option to add a new email
account. Once you have email accounts set up they will also be listed
on this screen.

Step 2

Enter in the box the email that you want (such as support or your

name ...etc)
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Step 3
Below that enter a password for the new email account. This is the
password you will use to access your emails.

Step 4

Enter the password again below to confirm

Step 5

Enter the quota size for the email account. This is how much memory
the email account can hold. You can leave this though as it is because

you can always change this in the future if needed.

Step 6
Click the ‘Create’ button

And that’s that!! You now have an email account that you can log into

to send and receive emails. You can create an unlimited amount of
these so go ahead and set up the ones you want.

Ok, so once you have done all the above you will have your blog up
and running with all the essentials in place.

Feels good right?!

Seriously... Well done!!

You are already ahead of so many people ©

Now its time (if you wish) to customise your blog a little

Yes I’'m talking about changing the theme of your blog, by theme I am
talking about the look of your blog. Now you can get hundreds and
hundreds of themes for free online or if you really want to go that
extra step you can pay for more unique themes.

So, let me show you how it’'s done, again I'll take you by the hand step
by step... Once you have learnt this you will be able to do it with ease.
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Changing the theme of your blog

There are many places online you can get Wordpress themes, just do a
simple Google search for ‘Wordpress themes’ and you can look around
what’s on offer.

There is an official site though that | recommend as all the themes are
checked to ensure they work correctly.

Go here to see them -
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Once you have found one you like click the ‘Download’ button for
your chosen theme, you then want to choose to ‘save’ the zip file to
your computer.

Once you have the theme zip file saved you need to go log into your
hosting cPanel.

Then go to the ‘File manager’ icon and click that, on the pop up box
click ‘go’ to access the ‘web root’ of your site.
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Ok, now you are looking at the file manager screen let me do this step
by step for you to follow;

Step 1
Find the folder called ‘wp-content’ and double click the little blue
folder icon to the left of that to open up the ‘wp-content’ folder

Step 2
Find the folder called ‘themes’ and double click the little blue folder to
the left of that to open up the ‘themes’ folder

Step 3

Once you are in the ‘themes’ folder you need to find the ‘Upload’
icon. This is located to the top of your screen within a list of icons,
once you find it click on it to open up the upload screen

Step 4
Click on a ‘browse’ button to open up a new screen of your computers
files and folders

Step 5

Select the zip file of the theme you saved to your computer earlier and
click ‘open’

This will now upload the zip file of your theme into your themes folder
of your cPanel. Once this tells you it is 100% complete click the text
that reads something like this:

Back to /7home/*YOUR LOG IN NAME*/public_htmIl/wp-
content/themes
This will take you back to your themes folder where you should see the
name of your new theme in the list as a zip file.

Next follow these steps;

Step 6
Right click on the new theme name in the list and select to ‘Extract’
the file contents

Step 7
On the pop up box click ‘Extract file’. Another pop up box will confirm
it has been done; you can just close down this box.
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Ok, so that is it for this part. You now need to go over to your
Wordpress blog admin and log into your dashboard.

Once logged in you need to click the ‘Design’ tab and you will then
see the available themes for your blog. This will now include your new
chosen theme that you just uploaded ©

Now you want to click on the screen shot of your new theme which will
bring up a preview of that theme.

Now in the top right corner you will see some text that says ‘Activate’
Click on that to activate your new theme ... And that’s it!!
Go look at your blog with its new theme, looks good right?! Well done

Remember if you ever want to get a new theme you can, just repeat
the above steps.

I know the above steps may have seemed lengthy but its really quite
simple, because | wanted to lay it out in very simple steps it may of
appeared difficult but you will see it’'s not too bad.

Add plugins to your blog

Plugins... What are they??

Well plugins basically extend the features of your blog, there are
literally thousands of plugins available for you to download and add to
your blog.

An example of a plugin is ‘post teaser’, if you look on my blog
www.DeanHolland.com you will see that all my posts on the home
page are teasers of the posts. To read the full post you need to click
on the post title, well that is a plugin that makes that happen.
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To see what plugins are available to you go here;

23 WordPress » WordPress Plugins - Microsoft Internet Explorer
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There are a lot to look through but take some time to see which ones
you want to use on your blog.

So once you found one or more that you want you need to download
them and install them as you did with your theme.

The process is actually quite similar to the way you did the theme but
I will walk you through this again step by step so you don’t struggle.

Once you have found a plugin you like click the ‘Download’ button,
you then want to choose to ‘save’ the zip file to your computer. Once
you have the plugin zip file saved you need to go log into your hosting
cPanel.

Then go to the ‘File manager’ icon and click that, on the pop up box
click ‘go’ to access the ‘web root’ of your site.

Ok, now you are looking at the file manager screen let me do this step
by step for you to follow;
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Step 1
Find the folder called ‘wp-content’ and double click the little blue
folder icon to the left of that to open up the ‘wp-content’ folder

Step 2
Find the folder called ‘plugins’ and double click the little blue folder to
the left of that to open up the ‘plugins’ folder

Step 3

Once you are in the ‘plugins’ folder you need to find the ‘Upload’
icon. This is located to the top of your screen within a list of icons,
once you find it click on it to open up the upload screen

Step 4
Click on a ‘browse’ button to open up a new screen of your computers
files and folders

Step 5

Select the zip file of the plugin you saved to your computer earlier and
click ‘open’

This will now upload the zip file of your plugin into your plugins folder
of your cPanel. Once this tells you it is 100% complete click the text
that reads something like this:

Back to /7home/*YOUR LOG IN NAME*/public_htmIl/wp-
content/plugins
This will take you back to your plugins folder where you should see the
name of your new plugin in the list as a zip file.

Next follow these steps;

Step 6

Right click on the new plugin name in the list and select to ‘Extract’
the file contents

Step 7

On the pop up box click ‘Extract file’. Another pop up box will confirm

it has been done; you can just close down this box.

Now once again head over to your blog admin area
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Now near the top of your screen on the right hand side you are looking
for the ‘Plugins’ tab ( You will find it in between the ‘Settings’ and
‘Users’ tabs )

Once you find it, click on it to access the plugins screen

Now you will be on the plugin management page, if you scroll to the
bottom of the page you will see a list of inactive plugins.

Your new plugin(s) will be there and to begin using it you need to click
to ‘Activate’ the plugin

Ok, now that you have activated it you can begin to use it. As every
plugin is different you will need to look how you begin to use the
plugin, as long as | have shown you how to install and activate them
you will figure out how to use them I'm sure.

You can repeat the above steps to install and use all the plugins you
wish with your blog, hope that helps.

And that my friends as they say... is that ©

Summary

Hopefully you found this book useful and it has walked you from start
to finish getting your own blog live on the internet.

Just think, your new blog is the start of the future!!
How big you want that to be now depends on you.
Just continue to take action and go forwards every possible day

Please keep in touch on my blog at www.DeanHolland.com

Together we will succeed...Lets do this now!!

Dean Holland
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>>> Special Unannounced Surprise <<<

I have a great surprise for you, call it a gift from me to you ©

So to run a proper online business and build a life long income you
need to build an email list, this is a list of people that subscribe to be
on your email list that you can then contact in the future.

That’s where the saying comes from - “The money is in the list”

However to build your list you need to offer something to your website
/ blog visitors to get them to subscribe to your list

So here’s what I'm gunna do for YOU....

I’m giving you MASTER RESALE RIGHTS to this book for Free !!!

So what does that mean ??

Well I'm giving you the right to give this ebook away on your website
or blog to your visitors. You can do as you wish but ...

You CAN NOT change any of the content within this product, it must
be given away in the exact same form that you see it here...

There you go !! My gift to you
So go build yourself a monster list with it ©
For more info on list building claim your free system here;

www.ListMachineDean.com

Disclaimer

The creator of this product did so using their best efforts and all the information at their
disposal. The author gives no guarantees as to the outcome of following the information
contained within. The information provided is as an information & educational guide only.

Any action taken based upon the information given is done so at the readers own risk.
There are no warranties either expressed or implied as to the effectiveness or otherwise

of the information disclosed and the author shall in no event be held liable for any
damages or other loss resulting from following all or any of the information contained
within.
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To you the reader, thanks for getting this far, if you take action and follow the
instructions | have provided; you will soon be blogging and making an income online.

Don’t forget, if you need me | am there for you, just shoot over to my blog,

http://www.deanholland.com

Good Luck!
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